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Introduction

@o Before You Start...

% If you run into problems at any point please stop and seek assistance from Ex Libris Global Customer Support.

% The Oracle 10g client replaces any pre-existing client and is backwards compatible with Oracle 8i & Oracle 9i
servers.

% Make sure your Windows login has Local Administrator rights before you begin. Your IT Department can assist you
on resolving this if you are unsure or do not have Local Administrator rights.

% Once the uninstall process has started, do not leave it unattended or start working on a different application until you
have completed the process. Doing either may cause the application to freeze and require a reboot to resolve.
Rebooting at the wrong time could greatly complicate the uninstall process.

% Shutdown all other applications. Temporarily disable any PC firewall & virus software before running the applications.

% If you are running Norton AntiVirus 2006 or later, ODBC linking will not work by default. Read Microsoft's
Knowledge Base Article 329820 for help. Otherwise, consult with your IT department.

% The Ex Libris Automation Tool is designed and tested for use with Voyager.
% If you have other Ex Libris applications please contact Ex Libris Global Customer Support for assistance.
% If you have non-Ex Libris applications that use ODBC check with your IT Department before proceeding.

% The screenshots provided in this document were taken using Windows XP. If you are running a different version of
Windows, your screen may appear slightly different.

% If this is a new install of the ODBC drivers, you can skip the Backup and Uninstall sections of the document.

:JJ
@ A Note on Terminology...

% You may read or hear a reference to a driver CD. Years ago, the ODBC drivers were shipped out on a CD, but the
prevalence of high-bandwidth network connections has made CD distribution obsolete.

% You can burn the contents of the downloaded zip file to a CD for archival purposes or for intra-library installation.

% If persistent network issues prevent you from downloading the zip file, you can request a physical CD from Ex Libris.
Please specify if you need the CD for Windows XP or Windows Vista. There may be a delay in preparing and shipping
the CD.

Why all the reboots?

For a cleaner and faster uninstall (and install) process. Rebooting the PC...
% ...just before critical work helps minimize services competing for system resources.
% ...then shutting down all other programs minimizes program fragments and memory leaks.

% ...after making registry changes ensures that the link between PC files and previous registry data no longer exists.
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Downloading the Oracle 10g Client Package

Before You Start
1. Disk Space & Directories

a. Disk Space
i. The download requires 500MB free space.
ii. The installation requires an additional 500MB free space.
b. Create a directory on your PC where you will extract the package, such as C:\Oraclel0Og.
2. Support Web.
a. Ensure you are able to login to Support Web.

b. Contact Ex Libris Customer Support for the odbc password.

Instructions
1. Download the package

a. Go to the Oracle 10g ODBC download page on Support Web:

https://support.endinfosys.com/cust/oracle10.html

b. Click on the link to download the file appropriate for the PC’s Operating System:

Ex Libis Supported Products Work with the Oracle® 10g Client and ODBC

ODBC Documentation: E Oracle® 10g ODBC Installation Guide (Automated Method)

ODBC Drivers: Version 10201 (Windows® 2000 & Windows® XFP)
Version 10203  (Windows Vista™)

i. Version 10201 for Windows XP™,
ii. Version 10203 for Windows Vista™.

c. You will be prompted to enter the password for the odbc user:

User: odhbc

Password: I*********

Submit | Cancel |

Confidential and proprietary information of Ex Libris Group, Inc. Reproduction or republication of this information in any form is strictly prohibited without
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d. Save the file to your PC just as you would for the Voyager clients.
i. Be sure to remember where you save the file.
ii. Do not select Open at this time.

e. Wait for the download to complete.

i. This file is very large (over 400MB); depending on the speed of your connection, it can take up to
an hour to complete.

2. Extract the package
a. Extract the downloaded file to the directory created on page 4.
i. The WinZip software is commonly used for this process.
ii. Check with your IT department if you are unsure which program to use.
b. Ensure you preserve the folder names when you extract the file.
i. In WinZip you check the Use folder names option.

ii. Check with your IT department or software vendor if using other software.

The Oracle 10g ODBC package is ready to install!
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Running the Ex Libris Automation Tool

Before You Start

Be sure you have downloaded and extracted the Oracle 10g Client Package as outlined in Downloading the Oracle 10g
Client Package.

Instructions
1. Go to the package directory.

a. The following assumes you extracted the package to C:\OraclelOg
b. Double-click on My Computer
.Il
48
by =

c. Double-click on the C: drive

't%’-_‘] Local Disk (C:)

d. Double-click on Oraclel0g
Orade 10g

e. Double-click on the package directory

i. For Windows XP™ the folder is 10201_client_win32

,’] 10201_dient_win32

ii. For Windows Vista™ the folder is 10203 _client_vista

’/] 10203_dient_vista

2. Start the Ex Libris Automation Tool

a. Double-click on the BEAT icon

BEAT.bat

Confidential and proprietary information of Ex Libris Group, Inc. Reproduction or republication of this information in any form is strictly prohibited without
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b. The following screen should appear:

WINDOWS" system 32 cmd.exe
Brian's ExLibris Automation Tools (BEAT> — Oracle Client Configurator

Backup ?i tnsnames.ora
Remove Oracle ?i Client

Update tnsnames.ora
Update ODBC Configuration

. Install Oracle 1@i Client
: Quit

Please Make a Selection:

You have now started the Ex Libris Automation Tool!
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Backup Current Oracle Configuration

Page 8 of 20

Before You Start

This step should only be run if there is already a working Voyager ODBC configuration. If your PC has never had Oracle

ODBC drivers on it, you can jump ahead to Installing Oracle 10g on Page 12.

Instructions
1. Restart your computer

a. Login to the PC.

b. Ensure there are no open programs
2. Start the Ex Libris Automation Tool
3. Backup TNSNAMES.ORA

a. Select option 1. Backup 9i tnsnames.ora

WINDOWS system32 cnd.exe

Brian's ExLibris Automation Tools (BEAT> — Oracle Client Configurator

Backup ?i tnsnames.ora
Remove Oracle 9i Client
Inztall Oracle 18i Client
Update tnsnames.ora
Update ODBC Configuration
Quit

Pleaze Make a Selection:

b. Notepad will open displaying a thsnames.ora file:

P thsnames.bak - Notepad

File Edit Format Yew Help

=101 x|

# Created by Endeavor Information System.

ViZER =
(DESCRIPTION =
(ADDRESS_LIST =

{COMMECT_DATA =
(SID = WEER)
p]

)
< |

# THNSMAMES.ORA Network Configuration File: Cihoracleynetwork“adminitnsnames.ora -

(ADDRESS = (PROTOCOL = TCPJICHOST = 333, 200, 5000 000 (PORT = 152170

Confidential and proprietary information of Ex Libris Group, Inc. Reproduction or republication of this information in any form is strictly prohibited without
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c. Compare the displayed file to the screenshot above.
i. If the displayed file and the screenshot look similar proceed to step 3.d

ii. If the displayed file is blank or significantly different then the screenshot STOP and contact Ex
Libris Global Customer Support immediately.

d. Close Notepad

e. Press any key to return to the Ex Libris Automation Tool

The Oracle ODBC configuration is now backed up!

O
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Uninstall Previous Versions of Oracle

Page 10 of 20

Before You Start
This will remove any current Oracle 8i, 9i, or 10g client installed on your system

Instructions

1. Restart your computer

a. Login to the PC

b. Ensure there are no open programs
2. Start the Ex Libris Automation Tool
3. Remove Oracle clients

a. Select option 2. Remove Oracle 9i Client.

WINDOWS' system3 2 cmd.exe
Brian’'s ExLibris Automation Tools (BEAT> - Oracle Client Configurator

Backup ?i tnsnames_ora
Hemove Oracle 9i Client
Inztall Oracle 18i Client
Update tnsnames.ora
Update ODBC Configuration
Quit

Please Make a Selection:
b. You will be prompted to “Press any key to continue . ..".
Do not press any key!

c. Typeremove and hit enter:

co L WINDOWS' system32h cmd.exe

Please contact support to use this option
Press any key to continue . . . remove_

d. Enter Y and hit enter if you are sure you want to remove all existing Oracle clients:

0 CWINDOWS' system 32 cmid.exe
Please contact support to use this option

Press any key to continue . . . remove
Are you really sure vou want to do this?? (Y/HI:- u
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e. You will see a number of errors on the screen. These are normal and can be ignored:

G WINDOWS' system32cmd.exe
The specified service does not exist as an installed seruvice.

System error 1868 has occurred.

The specified service does not exist as an installed sewvvice.

The OracleMISRecoveryService service is not started.

More help is available

cannot
cannot
cannot
cannot
cannot
cannot
cannot
cannot
cannot
cannot
cannot
cannot
cannot
cannot

find
find
find
find
find
find
find
find
find
find
find
find
find
find

by typing NET HELPMSG 3521.

the file specified.
the ifi
the

the

the

the

the

the

the

the

the

the

the

the

to continue . .

f.  When prompted press any key.

4. Restart your computer

a. Login to the PC.

b. Ensure there are no open programs.

5. Repeat

a. If this is the first time reaching this step repeat this procedure starting at Step 2.

b. If this is the second time reaching this step you are done.

Pre-10g Oracle ODBC is now successfully uninstalled!

q

Page 11 of 20
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Installing Oracle 10g

Before You Start

Be sure that you have the Oracle 10g installation for your version of Windows, supplied by Ex Libris. The Oracle 10g CD
from Oracle cannot be used with this procedure. See Downloading the Oracle 10g Client Package for more
information.

Instructions
1. Restart your computer

a. Loginto the PC

b. Ensure there are no open programs
2. Start the Ex Libris Automation Tool
3. Install Oracle 10g

a. Select option 3. Install Oracle 10g Client

" WINDOWS' system32h cmd.exe
Brian's ExLibriz Automation Tools <(BEAT> - Oracle Client Configurator

Backup ?i tnznames.ora
Remove Oracle 9i Client
Inztall Oracle 18i Client
Update tnsnames.ora
Update ODBC Configuration
Quit

Pleaze Make a Selection: 3
b. When prompted answer Y to install the Oracle 10g client

c. Do not attempt to change the window focus during this process!

Confidential and proprietary information of Ex Libris Group, Inc. Reproduction or republication of this information in any form is strictly prohibited without
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d. Wait for a message indicating that the installation has completed

Installation in progress (Fri Jun B1 16:88:56 CDT 2887>

78 Done.
Install successful

Setup in progress (Fri Jun 81 16:83:87 CDT 2087)>

toLoad is C:s\DOCUME™1BStratma~LOCALS™1\Temp*Oralnstall2@@7-06—01_A4—HA-B8PHoc x|
Reg.dll

Setup successful

End of install phases.(Fri Jun 81 16:83:31 CDT 2087>

Btarting to execute configuration assistants

Conf iguration assistant "Oracle Net Configuration Assistant' succeeded

The installation of Oracle Client was successful.

Please check ‘C:»\Program Files“OraclesInventoryslogsssilentInstall2@@7Y-06-01_@4-
AA-A8FPM.log’ for more details.

Please press Enter to exit...

e. Hit enter to close the install windows

f.  Hit enter to return to the Ex Libris Automation Tool

Oracle 10g ODBC is now successfully installed!

N~
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Oracle Configuration

Before You Start

If this an UPGRADE from Oracle 9i and the steps in the Backup Current Oracle Configuration section were followed,
proceed to the Upgrade Instructions section.

If this is a NEW installation of Oracle 10g proceed to the New Install Instructions section.

Upgrade Instructions

1. Restart your computer

a. Login to the PC

b. Ensure there are no open programs
2. Start the Ex Libris Automation Tool
3. Restore TNSNAMES.ORA

a. Select option 4. Update tnsnames.ora

MWINDDWS system32, cmd.exe
Brian's ExLibrisz Automation Tools (BEAT>» - Oracle Client Configurator

. Backup ?i tnsnames.ora

. Remove Oracle ?i Client

. Install Oracle 18i Client
. Update tnsnames.ora

. Update 0DBC Configuration
. Quit

Pleaze Make a Selection:

b. Select option 7. Restore backup TNSNAMES

c. Enter Y if you are sure you want to restore

Restoring tnsnames.ora...

Are you sure you want to retore? CYoNI:

d. Hit enter to return to the Ex Libris Automation Tool

New Install Instructions

1. Restart your computer

a. Loginto the PC

b. Ensure there are no open programs
2. Start the Ex Libris Automation Tool

3. Create a TNSNAMES.ORA

Confidential and proprietary information of Ex Libris Group, Inc. Reproduction or republication of this information in any form is strictly prohibited without
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a. Select option 4. Update tnsnames.ora

WINDOWS" system 32 cmd.exe
Brian's ExLibris Automation Tools (BEAT> — Oracle Client Configurator

. Backup ?i tnsznames.ora

. Remove Oracle ?i Client

. Install Oracle 18i Client
. Update tnsnames.ora

. Update ODBC Configuration
. Quit

Please Make a Selection:

b. Select option 1. Add VGER Instance — Voyager

\WINDOWS\system32\cmd.exe
‘s ExLibriz Automation Toolz C(BEAT> — Oracle Client Configurator

Update tnsnames.ora

Add UGER Instance — Uoyager
Add MRDN Instance — Meridian
fidd EMC Instance — Encompass
fdd Image Server Instance

Add Custom instance

Save and Clear TNSMAMES
Restore hackup THSMAMES

Back

Quit

= - - O - L Y

Please Make a Selection:

c. Enter the IP Address of your Voyager server

e CY\WINDOWS\system32\cmd.exe i
Adding VYovager — UGER instance to tnsnames.ora

Please enter the IP address of your voyager database server:

d. EnterY to confirm when prompted
Hit Enter to return to the Ex Libris Automation Tool — Update tnsnames.ora section

e. Enter B. Back to return to the Ex Libris Automation Tool

Oracle 10g ODBC is now successfully configured!

Q5
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Link Prepackaged Reports

Before You Start

Be sure that you have gathered the following information. If you are unsure of any of the following, please contact Ex
Libris Global Customer Support.

® Your database name
® [For example: xxxxdb

® Your read-only login and password (usually written as login/password)
® Username =ro_xxxdb
Password = ro_xxxdb
® ro_xxxdb/ro_xxxdb

® Database server name or IP address

® Oracle SID

® [or Voyager 5.0 or higher, your SID is VGER
® [or Image Server your SID is VGER

® [or an earlier version of Voyager or Endeavor Heritage Digital Products contact Ex Libris Global Customer
Support.

Voyager Database Name:

Read-only User Login:

Read-only User Password:

Server Name or IP Address:

Oracle SID:

Confidential and proprietary information of Ex Libris Group, Inc. Reproduction or republication of this information in any form is strictly prohibited without
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Instructions
1. If you are using MS Access 2003 or later:

a. Start MS Access

b. Select Tools->Macro->Security->Security Level
c. Selectthe Low option

d. Click OK

e. When prompted click Yes

f.  You must close and restart MS Access

2. Open the Voyager Access Reports file
a. Thisis also referred to as the Reports.mdb file.

b. If this file does not exist check that Voyager Access Reports was installed.

3. Get External Data

a. Select File->Get External Data->Link Tables

Microsoft Access

i File | Edit Wiew Insett Tools ‘Window Help  Adobe PDF
] Hew.. Chel+M

o[ open... el T Lo |2

’;| Get External Data

Close %3 Link Tables... g
i = el

-

}'t_:, Irmportt...

b. A Link screen will appear

i. Click the Files of Type drop down located at the bottom of the screen
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ii. Select ODBC Databases, usually located at the bottom of the list:

Lok in | 3 My Computer v @- | @ X i - Took-
3, e Lacal Disk (1)

“eDATA (D1}

My Recent WorcLoz01_L (B
Diocurnents

i
L AR
AN

My Documents

=

File name: | I | Link

My Network.
Places

]

Files of type: |Micrnsnft OFfice Aiccess (*,mdb;*,mda;*, mde) [ Cancel
HTML Documents (. html* . htm)
Cutook()
Paradox (*.db)
Text Files (*,Exk;* oo™ kab;*, asc)
ices

‘indowes SharePoink
oD

c. The Link screen will be replaced by the Select Data Source screen
i. Selectthe Machine Data Source tab.

ii. Selectthe Data Source Name that matches the Oracle SID: from page 16:

Select Data Source

File Data Source  Machine Data Source ]

[ata Source Mame Tupe Ciescription
dBASE Files Usger
Excel Files Uszer
M3 Access Database Uszer

RTIFULCRUM Spstemn  RTIFULCRUM
YGEER Swstem  tables

N

ii. Click OK
d. The Select Data Source window will be replaced by a Microsoft ODBC for Oracle Connect window.
i. For User Name enter the Read-only User Login from page 16.

ii. For Password enter your Read-only User Password from page 16.

ii. For Server enter your Oracle SID: from page 16.

iv. Click OK.
icrosot 0DBC for Orace Comect_Ed|
User Name: In:u_mdb OK I
Password: I"““""| Cancel |
Server: I"-"GEH Help

NOTE: It may take a few minutes before the next screen appears.
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e. The Link Tables screen will appear

Link Tables

Tables |

WALl ALL TABLES ~ [a]’d

ALL ARGLUMENTS =

ALLTLUSTER,
ALL_CLUSTER _HASH_EXPRESSIONS

ALL_CLUSTERS

ALL_COL_COMMENTS
ALL_COL_PRIVS

ALL_COL_PRIVS_MADE
ALL_COL_PRI¥S_RECD

ALL_COLL_TYPES

ALL_COMS_COLLMNS

ALL_COMSTRAINTS 8| []5ave password

i. For Voyager
1. Click Deselect All
2. Click OK
ii. For Endeavor Heritage Digital Products
1. Click on the first table so that it is selected

2. Scroll to the bottom of the list

3. Hold down the SHIFT key and click on the last table

4. Click OK
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5. Contact Ex Libris Global Customer Support for assistance in completing your installation.

4. Build Database Links

a. Under Objects select the Forms option

[ Reports : Database (Access 2000 file format) |’._||’E|E|
Lﬁ Open %Q&sign ] Mew | X | 20
Obijects Create Faorm in Design view
1 Tables Create Form by using wizard
E;j e EBuild database
% Vovager Recard Counts
| -3 Faorms
@ PReports
'ﬂ Pages
2 Macros
&2 Modules %
Groups
%] Favorites
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b. Double-click Build database links to Voyager
c. The Build links to Voyager screen will appear
i. For ODBC Name enter the Oracle SID: from page 16.
ii. For Connect String enter the Oracle SID: from page 16.
iii. For DB User ID enter the Read-only User Login from page 16.
iv. For Password enter the Read-only User Password from page 16.
v. For Tablespace enter the Voyager Database Name from page 16.
vi. Ensure the Relink box is checked.
vii. Click Connect.

Build database links to Voyager

DDEC Name: [VGER
Connect String: |VGEFH
DE User ID: |lo_:-c:-c:-cdb

Password; [

Tablezpace: |:4>::<dl:- v FRielink

| LCancel | Cloze |

viii. The bottom window will list each table as it is successfully linked. The ALL_TAB_COLUMNS
table will not link. This is not an error.

ix. Once the tables have completed linking click Close.

Prepackaged Reports are now successfully linked!

\|/
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